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0. Introduccion

Bienvenido a Adobe Premiere. Adobe Premiere sustituye la tradicional mesa de mezclas con dos videos
conectados y te ofrece la posibilidad de hacer ediciones digitales de tus videos caseros (o no tan caseros) lo que
incluye transiciones, filtros y muchas mas cosas.

Trabajar con Adobe Premiere supone un proceso similar a realizar una comida. Primero conseguimos los
ingredientes (videos, fotos, audio, animaciones, etc) Poco a poco, vamos afiadiendo los ingredientes (edicion),
teniendo en cuenta que a algunos de ellos habra que darles un toque especial (cambio de formato, filtros,
retoque, etc) Finalmente, cuando hayamos mezclado todos los ingredientes, lo dejamos cocer (exportacion) y
finalmente tendremos el guiso preparado (video final). Después viene lo mejor de todo: servirlo a los comensales
que alabaran nuestra comida o, si todavia somos un poco novatos, se levantaran de la mesa "a medio comer" o
tendran una pequefia "indigestion" Como en cualquier comida, el principal ingrediente es el "amor" que se le
pone, o dicho de otro modo, la calidad del resultado final esta directamente relacionada con el interés y
esfuerzo que le dediques a la edicidn, asi que tomatelo con calma y dedicale su tiempo.

Cualquiera que me conozca sabe que soy un fanatico del Premiere ;Porqué? Porque es un programa abierto
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que no acaba en el Adobe Premiere que nos queda terminada la instalacion. Los programadores dejaron una
"puerta abierta". La principal potencia de los productos Adobe es su capacidad de admitir "plug-ins" o afiadidos
que permiten precisamente eso, afiadirle funcionalidades no previstas en la version inicial. Hay muchas
compatiias de software dedicadas en exclusiva a disefiar plug-ins para los productos de Adobe (filtros,
transiciones, tituladores, compresores, etc) de modo que, encontrando el plug-in adecuado, podras hacer cosas
que ni te imaginas en la version estandar.

Bueno... antes de seguir indicar una cosa. Esta primera parte de Premiere es un auténtico cofiazo, lo
reconozco, pero hay que saberla. Lo que gusta es conducir, pero si no sabes donde se mete la llave para arrancar
el coche, si no sabes cambiar de marcha, si no sabes por donde se le echa la gasolina... no vas a llegar muy lejos.
Por eso, aunque sea un poco rollo, antes de ponerte manos a la obra deberias ir paso a paso y dejarlo todo
configurado y preparado para poder hacer la edicion tranquilamente sin que surgan problemas de esos que nunca
sabes como solucionar.

1. ;Qué version de Adobe Premiere?

En espafiol solo tenemos la version 5. La ultima, la 6, unicamente esta disponible en inglés, pero para eso
tienes este manual :-) y, si quieres, hay un parche en la seccion de descargas para pasarlo a espafiol. Las
principales diferencias entre una version y otra estan en que la 5 todavia no maneja camaras DV ni archivos de
audio MPEG Layer-III (mp3 para los amigos) y que se modifica el modo de aplicar los filtros, pero, desde mi
punto de vista la principal diferencia esta en que, por fin, Premiere 6 admite los plug-ins de After Effects,
motivo, al menos para mi, suficiente para usar la 6.

2. Primer paso: eligiendo proyecto

La primera vez que usamos Premiere tras el proceso de instalacion, aparece una pantalla preguntandonos
como queremos trabajar. Si estas usando este manual es porque no tienes mucha idea de Premiere, asi que te
recomendaria usar el método A/B, puesto que es mas "intuitivo". Aunque esta pantalla aparecera tan solo la
primera vez que iniciemos Premiere, si quisiéramos, en un futuro puede cambiarse (Ver 3.2.1 Las pistas de
video), de modo que pinchamos en el boton marcado en la imagen (Select A/B Editing - Seleccionar edicion
A/B) y pasamos al siguiente paso.

IMPORTANTE: Evitemos
confusiones desde el principio. Con el
proyecto tan solo definimos como

— | "vemos" nuestro trabajo mientras

Y estamos manos a la obra, pero no
vemos el resultado final, tal cual
quedara una vez finalizada la edicion.
Es una especie de "borrador" en el
que ir trabajando, pero *NO* es el

Flease select an initial workspace:

— & /B Editing

— Single-Track Editing

This warkspace provides editors
with a wisual view of the timeline,
where clips and transitions are
displayed on separate fracks.
Select this workspace if you are
nev 1o video editing.

Select 4 /B Editing

This warkspace provides editars
with a traditional timeline, where
Clips and transitions are displayed
on the sarme track, but can be
viewed as two tracks. Select this
Workspace if you have experience
in videa editing.

formato definitivo, lo que vemos en el
monitor o ventana de construccion
*NO¥* es, necesariamente, lo que
veremos una vez terminada la edicion
y exportado el video.A la hora de
definir el proyecto hemos de valorar
mas la rapidez por encima de otra
consideraciones como la calidad final.

No obstante, hay dos situaciones en las que *SI* es recomendable definir el proyecto con los ajustes que
vamos a querer para el formato final

1. Si vamos a usar la opcion "Print to video" para reproducir el video directamente desde Premiere y grabar el
resultado en VHS. (ver 3.1 Volcar a video (print to video)
2. Cuando trabajamos con DV
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La siguiente pantalla aparecera cada vez que iniciemos Premiere y en ella decidimos lo que vamos a hacer.

Load Project Settings

Ayailable Presets

— Description |
P20 ov-nwrsc [~ | Ok
% (1] 0% - PAL For editing with IEEE1394 (FireiWire /iLINK} DY ;|
) equiprnent. Cancel |
[] Standard 32kHz Standard PAL video (4:3 interlaced].
B Standard 48kHz 45kHz (15 bit) audio.
[] ‘Widescrean 32kHz Custom... |
D Widescrean 48kHz ;I

(] Multimedia QuickTime Delate |

. o . Yideo Settings
D Multirmedia Yideo for Windows Compressor: Microsoft DY fPaL)

D NTSC Q480 QuickTirne Frame Size: 720 = 576 CIpen... |
Pixel Aspect Ratio: D1/DY PAL (1.067)

D NTSC 640420 Yideo for Windows
Frame Rate: 25.00

[ NTSC 720480 QuickTime Depth: Millions, Cuality: 100% Hel

(] NTSC 7205480 Yideo for Windows =lp |
N Audio Settings

[ PAL CuickTime Rate: 48000, Format: 16 - Stereo

D FaL Wideo for Windows Compressor: Uncompressed

Rendering Options
Field setting: Lower Field First

Si ya teniamos un proyecto a medio y queremos seguir trabajando con ¢l, la opcion a elegir sera "Open"
(abrir), de lo contrario, deberemos elegir como va a ser nuestro proyecto (recuerda que, excepto para VHS y DV
*NO* tiene NADA que ver con el formato final del video, solo con el modo en que trabajaremos en pantalla)

Si vas a trabajar con una camara miniDV la mejor opcion serd, sin duda, que selecciones un proyecto DV
acorde con tu formato de trabajo. PAL para Europa, NTSC América y Japon, Standar para 4:3, WideScreen
(panoramico) para 16:9. Los ntimeros 32 kHz y 48 kHz indican la frecuencia del audio. CONSEJO tanto para
grabar con tu videocamara, como para usar Premiere, usa siempre 48 kHz. Si el formato final va a ser DVD, no
hara falta cambiar de frecuencia de muestreo y si el destino es VCD / SVCD o derivados, la frecuencia sera 44.1
kHz. En cualquier caso, seleccionar 32 kHz supondria tener que aumentar luego la frecuencia final, lo que
normalmente empeora la calidad del audio y puede provocar desajuste en la sincronizacion. El proceso inverso,
sin embargo (pasar de 48 a 44.1 kHz), se realiza mas comodamente y con mejores resultados.

Si vas a trabajar con video capturado (da igual que esté capturado que por capturar) entonces lo mejor sera
elegir la opcion "Custom" (personalizado) y configurar nosotros mismos nuestro proyecto. Seria recomendable
que, una vez configurado nuestro proyecto (ver a continuacion) guardaramos los ajustes para no tener que
introducirlos una y otra vez y poder seleccionar nuestro proyecto directamente desde la pantalla de seleccion de
proyectos. Para ello basta con pinchar en el botén "Save" (guardar) Nos pedira un nombre y una descripcion y,
si marcamos la casilla "Include control devide settings" (incluir ajustes del dispositivo de control) se incluiran los
ajustes que hayamos definido para controlar una videocamara DV (ver 5.1.1 Ajustando las propiedades de
captura del proyecto)

2.1 General
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Project Settings

Ik

Editing Made:  [DV Flayback =l Advanced Settings | pom—
Timebase: |25 | Playback Settings |
Time Display: |25 fps Timecode =]
Load
Current Settings:  |Yideo Settings =
Cornpressor: kicrosaft Db (PaL) Save

Frame Size: 720 x 576

Pixel &spect Ratio: 01 /D% Pal (1.067)
Frame Rate: 23,00

Depth: Millions, Quality: 1002

Alldio Settings Prey
Rate: 48000, Format: 16 - Stereo j

ke b

[ext

- Editing Mode: DV Playback (para trabajar con camaras DV), AVI for Windows o, de haber instalado los
codecs, QuickTime

- Time Base y Time Display (base de tiempo y visualizacion de tiempo): Aunque *NO* es lo mismo que los
cuadros por segundo (fps o frames per second), no te compliques la vida y ajustala de la misma manera, es decir,
25 para PAL,. 29,97 para NTSC.

- Playback Settings (s6lo para DV o tarjetas capturadora con salida TV)

D¥ Playback Options ﬂ
—Cutput
.
¥ Playback on DY Carncorder A/CR;
¥ Playback on Desktop Cance| |

¥ Render Scrub Cutput to DY Camcorder AACR

—Audio
Audio will be plaved on your D% Carmcorder A/CR

W Play &udio on Desktop while Scrubbing

- Output:

NOTA: Estas opciones afectan a la reproduccion desde la linea de tiempo y NO a la exportacion, por lo que los
ajustes que definamos en el proyecto seran los que Premiere usara para la calidad final

Lo primero que tengo que decir es que, en el caso de DV, para que esta opcion funcione, tu videocamara ha
de tener activada la funcion DV-in. Todas las videocamaras hacen esta funcion, pero las mas baratas no la llevan
activada de fabrica, aunque se pueden activar mediante algunos trucos (a tu cuenta y riesgo, por supuesto)
Consulta la pagina http://www.imagendv.com/index.html para mas informacion al respecto

Para poder usar estas opciones con un video, necesitas una capturadora con salida de video compuesto.

Playback on DV Camcorder/VCR (reproducir en una videocamara DV o video): Es lo que parece, para poder
ver video en una fuente externa, esta opcion TIENE QUE ESTAR SELECCIONADA (lo esta por defecto)

Playback on Desktop (reproducir en escritorio): Cuando la salida de video esta activada desde Premiere se ve
la reproduccion de la linea de tiempo en la pantalla de la videocadmara o en un televisor. Si tienes seleccionada
esta opcion (Playback on desktop) el video también se vera en el monitor del ordenador. El ordenador tendra
entonces que procesar dos sefiales, por un lado la que le manda fuera y, por otro, la que muestra en la pantalla
del ordenador. Evidentemente doble trabajo supone doble probabilidad de verse mal. Cuando estés grabando el
resultado final deselecciona esta opcion para conservar recursos y si quieres ver el video utiliza tan solo la
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pantalla LCD de la videocamara o el monitor

Render Scrub output to DV camcorder /VCR (Ver el resultado de los renders en la camara DV/VCR): Con
esta opcion mientras el ordenador hace el render de algo, por ejemplo,de una transicion, un filtro, etc, etc
podras ir viendo el resultado en el televisor o en la pantalla de la videocdmara.

- Audio:

Por defecto el audio se reproducira en la fuente externa junto con el video. Si seleccionas ademas la casilla de
abajo también lo oiras por los altavoces del ordenador. Sucede lo mismo que con el video, dejas deseleccionada
esta casilla, consumiras menos recursos.

2.2 Video

Project Settings

—|Wideo =l "

Compressar:

[Inden® video 5.10 Cancel

Depth:

[Millions =l | Faette |

FrameSize: 720  h [576  w [ &:3 Aspect

L

Load

Save |
Frame Rate: |25 "I Pixel Aspect Ratio: |D1 D8 PAL (1067 LI
uality Data Rate
Lo |T“'5 b High [T Limit data rate to 1000 K fsec
Prey |
iy [~ Recompress  |&lways |

[ext

- Compressor (compresor) Aqui donde elegimos el codec (compresor) para trabajar en la ventana de
construccion (repito, NO para el formato final) Mis recomendaciones son, o bien NO usar (si tenemos espacio y
el disco es rapido) o bien usar huffyuv o Ligos Indeo con la opcion Quick Compress activada. El boton
"Configure" (configurar) nos llevara al ment de configuracion del codec que hayamos elegido, diferente en cada
caso. Es adecuado que te familiarices con los parametros de configuracion en cualquier codec. Consulta el
Manual de Primeros Auxilios y compresion AVI

- Depth (profundidad, en este caso de color): Menos colores significaran peor calida de PRE-visionado, pero
mayor rapidez de calculos. No todos los codecs admiten modificar esta opcion.

- Frame Size: A mayor tamafio, mayor tiempo de calculo. Sea cual sea el destino final, usa como méaximo el
tamafio del VCD (352x288 PAL, 320x240 NTSC) Con la mitad de ese tamafio (176x144 PAL o 160x120
NTSC) se consigue una velocidad muy rapida a costa de una calidad notablemente reducida. (Insisto una vez
mas... esta calidad es solo a la hora de trabajar, no para el resultado final)

- 4:3 Aspect Ratio: Recomiendo desactivar esta casilla e introducir las dimensiones de nuestro video de forma
manual, tomando como base los tamafios de video estandar,(ver tamafios de video)

- Frame Rate (Velocidad de fotograma) Aunque el estandar son 25 para PAL, 29,97 para NTSC, una tasa
menor supondra mayor velocidad de previos. Hasta 15 fps (frames per second - cuadros por segundos) no hay
una notable pérdida de calidad. (de hecho, la tasa de los dibujos animados es esa, de 15 cuadros por segundo) En
cualquier caso, el valor del flujo de cuadros del proyecto ha de ser multiplo par del flujo del video con el que
trabajemos

- Pixel Aspect Ratio: D1/DV PAL o D1/DV NTSC en el caso de trabajar con video DV. Square Pixels (1.0)
(pixeles cuadrados) en cualquier otro caso para evitar deformaciones.Ver Relacion de Aspecto

- Quality & Data Rate (Calidad y flujo de datos) Con algunos codecs (compresores AVI ) se activan estas
opciones. Si marcamos "Limit data rate" (limitar flujo de datos) limitamos el flujo de datos a la cantidad que le
indiquemos. Si marcamos "Recompress Always" las partes del video que superen ese limite, seran
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recomprimidas hasta no sobrepasar ese limite. En mi opinion, estas opciones no son muy ultiles en nuestro
proyecto puesto que buscamos rapidez y no perder el tiempo con compresiones y recompresiones.

2.3 Audio

N - —

Rate: [48000 He

Cancel

Eormat: |16 Bit - Stereo

Led Lef Led Lo

COMmpressor: |Unc|:|rnpre55ed Sdvanced Settings
Inter leave: |l Second Laad
— Processing Options Save

Enhance Rate Conversion: [Off

[~ Lke Logarithmic Audio Fades

Create audio preview files if there are: |5 or more active audio fracks
|1_ ar more audio filters applied

[ BE B

Prey

[ext

- Rate: Frecuencia de muestreo. 48.000 Hz para DV / DVD, 41.100 Hz para VCD / SVCD. A mayor
frecuencia., mas calidad de audio y mas tiempo de procesado

- Format: Formato del audio. Para calidad CD, 16 bits-Stereo (doble canal) Ocho bits-mono es el formato de
menos calidad, menos espacio y mas rapido, 16-bits-Stereo el de mejor calidad, mas espacioy mas lento

- Compressor (compresor) Para acelerar la edicion, lo mejor sera dejar el audio sin compresion, a costa de
aumentar el tamafo de los previos.

- Interleave (entrelazado) Este pardmetro define la frecuencia con la que el audio se carga en la memoria
durante la reproduccion desde la linea de tiempo: Valores mas alto requieren un menor acceso al disco duro para
leer audio a cambio de un mayor consumo de memoria.

- Enhaced Rate Conversion (Conversion de muestreo mejorada) Si la frecuencia de muestreo del audio de los
clips no es la misma que la del proyecto se produce una notable degradacion de la calidad en el proceso de
transformacion. Desde este apartamos podemos elegir una mejora moderada de dicho proceso (Good) o con la
maxima calida posible (Best)

- Use logarithmic audio fades (usar desvanecimientos de audio logaritmicos) Por defecto, Premiere hace las
transiciones de audio lineales. A través de esta opcion podemos indicarle a premiere que realice calculos
logaritmicos para hacer que las transiciones de audio suenen mas naturales, a costa, como siempre, de una
mayor tiempo de proceso.

- Create audio preview files if there are (crear previos de audio si hay)
- X or more audio tracks (X o mas pistas de audio)
- X or more filters applied (X o mas filtros aplicados)

El la edicion de video la mayor carga de procesado se la lleva el video, de modo que mientras editamos en la
linea de tiempo es frecuente hacer previos de video, pero normalmente el audio se lee directamente y, de
realizar alglin efecto, se puede hacer "al vuelo", en tiempo real, mientras vamos viendo el proyecto. A través de
éstas opciones podremos definir en qué casos se realizaran previos de audio. Cuanto mas potente sea nuestro
equipo, mas podremos "suavizar" estas condiciones.

2.4 Keyframes and rendering (Cuadros clave y presentacion)
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keyframe and Renderin I
I-'_ = ==L 22 II;I [:|K
— Rendering Cptions
. - . Cancel |
[ lgnore Audio Effects [~ Cptimize Stills
[ lgnore Yideo Effects [~ Frames Cnly at Markers
[~ lgnore Audio Rubber Bands Preview |From RAn > at |11 =] Load |
Fields: |Lower Field First =l save |

— Eeyframe Cptions

[ Eeyframe every |15 frrammes
[T &dd kKeyframes at Markers

I Add Keyframes at Edits Erev

L

Mext

2.4.1 Rendering options (opciones de presentacion)

- Ignore Video/Audio effects (ignorar efectos de video/audio) Se ignoran los filtros de video/audio a la hora de
hacer la representacon del video

- Ignore Audio Rubber Bands (ignorar tiradores de audio) No se representaran las transiciones de audio.

- Optimize Stills (optimizar imagenes fijas) Si incluimos una imagen que permanecera congelada unos
segundos, podemos indicarle a Premiere que, en lugar de calcular la misma imagen cuadro a cuadro, lo haga
solamente una vez para todos los cuadros en los que aparezca esa misma imagen de forma continuada. Esta
opcion es especialmente recomendable al hacer montajes fotograficos.

- Frame only at markers (representar solo en marcas) Con esta casilla solo se reprensentaran los puntos en los
que hayamos incluido marcas.

- Preview (previos) (ver 4. Vistas previas)

- To Screen (a pantalla): Con esta opcion veremos los previos tal y como quedaran, pero en caso de que el
procesador no pueda realizar todos lo célculos necesarios en tiempo real, seguiremos viendo cuadro a cuadro el
resutado final, pero la tasa de cuadros por segundo se vera reducida, en casos extremos de videos muy
complejos, hasta 1 cuadro cada varios segundos

- To RAM (hacia la memoria RAM): Los previos se muestran directamente desde la ventana de
construccion 100% en tiempo real. La utilidad de ésta opcion dependerd muy directamente de: la potencia de
procesado del equipo, cantidad de memoria disponible, tamafio de pantalla y los filtros aplicados. Puesto que
reproduce en tiempo real, si a Premiere no le da tiempo a realizar todos los calculos necesarios se produciran
saltos y/o degradacion de la imagen.

Con las opciones "To Screen” y "To RAM" podemos seleccionar 1:1, manteniendo las proporciones
originales del video, 1:2 para reducir la resolucion a la mitad, y con ellos calculos y tiempo de render, o 1:4
para reducir a un cuarto.

- To Disk (hacia el disco) Los previos solamente se muestran en pantalla una vez que han finalizado todos
los calculos. Por tanto se calculan primero en tiempo no-real y una vez finalizados los célculos se reproduce el
video en tiempo real y con todos los efectos. Realizar los previos desde el disco tiene dos ventajas: por un lado,
esos previos se quedan guardados, de modo que si no acabamos la edicién en una séla sesion, seguiremos
tieniendo nuestros previos para otra sesion. Eso a su vez supone la ventaja que, si exportamos el video en el
mismo formato que nuestro proyecto, no hara falta repetir los calculos.

- Fields (campos): Para esta opcion tendremos en cuenta las consideraciones indicadas en 2.4 Video
entrelazado (campos) / no-entrelazado y en 1.5 Field Options (opciones de campo)

- Para video con resolucion INFERIOR O IGUAL a 288 puntos verticales, selecciona SIEMPRE "No fields"
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(sin campos, o no entrelazado)

- Para video DV selecciona SIEMPRE Lower field (campo inferior o campo B)

- Para otro tipo de video capturado con mas de 288 puntos verticales depende EXCLUSIVAMENTE de la
tarjeta con la que fue capturado. Si no sabemos como capturd esa tarjeta el video no nos queda mas remedio que
exportar de los dos modos (con "upper field" primero y luego con "lower field") para averiguarlo.

2.4.2 Keyframing (cuadros clave)

- Keyframe every X frames (cuadro clave cada X cuadros) Ver 1.3.3. Keyframes

- Add keyframes at markers (afiadir cuadros clave en marcadores) Se afiade un cuadro clave en los puntos del
proyecto en el que hayamos incluido marcadores, independientemente de los demas cuadros clave.

- Add keyframes at Edits (afiadir cuadro clave en ediciones) Afiade un cuadro clave entre un clip y otro,
independientemente de los demas cuadros clave.

2.5. Capture (captura)

(Ver 5. Capturando con Adobe Premiere)

2.6 Guardando y abriendo proyectos

Para guardar nuestro proyecto usaremos la opcion "File -> Save" (Archivo -> Guardar)Para abrir,
normalmente lo haremos desde la pantalla de presentacion que sale al iniciar Premiere. También podemos con
"File -> Open" (Archivo -> Abrir)

Podemos decirle a Premiere que guarde el proyecto cada x minutos con la opcion "Edit -> Preferencies ->
Autosave & Undo -> Automatically save proyects, save every x minutes" (editar -> preferencias -> grabacion
automatica y deshacer -> grabar proyectos automaticamente, guardar cada x minutos)

UN TRUCO QUE OS PUEDE SALVAR LA VIDA: Ya sé que estas cosas nunca pasan... hasta que pasan.
Una vez fui a grabar el archivo y... jalehop! justo en el momento en que grababa se fue la luz. Cuando reinicié, el
archivo del proyecto estaba corrupto y no podia abrirlo. Mas de una semana de trabajo a la basura. No
resignandome a la desesperacion, me encontré que en la carpeta C:\Archivos de programa\Adobe\Premiere
6.0\Project-Archive se guarda una copia de seguridad de la penultima vez que grabaste el proyecto, con lo que la
pérdida de informacion es minima.

3. Terminologia usada en Premiere

Antes de avanzar, quisiera dejar clara la terminologia empleada en Premiere y a la que haré referencias
constantes a lo largo de todo el texto. Son conceptos que han de quedar claros para evitar confusiones o
malentendidos

3.1 Import (importar)

Es un término ya usado en muchas otras aplicaciones, y define el proceso de "afadir" un archivo cualquiera
(dentro de la gama que admite Premiere) a nuestro proyecto (ver 4. Importando nuestro material audiovisual a
Premiere). Su funcion se limita a decirle a Premiere donde estan localizados los archivos con los que vamos a
trabajar. Si los cambiamos de sitio nuestro proyecto quedara inservible. Bueno, no totalmente, pero tendremos
un "hueco" en las zonas en las que se usaba ese archivo. Si eso sucede, al abrir el proyecto Premiere nos
preguntara donde estan los archivos que faltan para poder seguir usdndolos con normalidad. Una vez importado
un archivo al proyecto no debemos modificar ese archivo JAMAS fuera de Premiere, so pena de tener que
ajustar de nuevo todos los clips en donde se use ese archivo

3.2 Project (proyecto)

Es un archivo muy simple (simple en comparacion con los archivos multimedia) que guarda datos tipo
"Vamos a trabajar con los videos a un tamafio de 352x288 con el compresor Ligos Indeo sin compresion de
audio. El proyecto comienza con el video 1, que usaremos del punto 02:24 al 05:23 en la pista ninero dos. Junto
con ese video hay una pista de audio de la misma duracion que comienza con un fundido desde cero. Al finalizar
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transicion con pista 1..." etc, etc, etc. Por eso decia que un proyecto es algo "simple" porque so6lo incluye las
instrucciones que introducimos nosotros en la lina de tiempo que es donde queda definido qué va a ocurrir con
cada uno de los clips (archivos de trabajo) que hemos utilizado en ella. El proyecto NO incluye por tanto ningin
tipo de archivo adicional, ni de video, ni de audio, ni grafico. Si tenemos un proyecto, pero no tenemos los
archivos con los que lo creamos, no tenemos nada.

3.3 Clip

Cada uno de los elementos que se manipulan en la linea de tiempo de Premiere se llama clip. Es decir, los
archivos de video, audio, imagenes y titulos son clips. Ahora bien. Es importante entender lo siguiente:

- Un clip es so6lo un clip cuando esté usado en la linea de tiempo

- Un clip, en si mismo, no es nada, es un "invento" que nos permite manipular con facilidad archivos
originales. Si tenemos un clip en la linea de tiempo y borramos el archivo orignal del que extraimos el clip, no
tendremos nada, puesto que el clip es una especie de "acceso directo" al archivo original.

3.4 TimeLine (linea de tiempo)

La linea de tiempo es la ventana de trabajo en la que vamos colocando los clips, indicandole a Premiere qué
tiene que hacer en cada momento con los distintos archivos que hemos importado. Puesto que la linea de tiempo
es la "base" de todo nuestro trabajo, la veremos en profundidad en el apartado La linea de tiempo

3.5 Preview (vista previa)
NOTA: Es muy comin denominar a éstas vistas prévias "renders" (presentaciones)

Si afiadimos un clip a la linea de tiempo podremos reproducirlo sin problemas en la ventana de monitor (la
"tele" donde veremos nuestro trabajo mientras estamos "manos a la obra") Sin embargo, cuando apliquemos
alglin tipo de filtro o transicion estaremos creando un video que no existe. El clip 1 existe, ya lo hemos
importado. El clip 2 también. Ahora los ponemos en la linea de tiempo y afiadimos una transicion que mezcle
final de uno, comienzo del otro. Esa "transicion" no existia anteriormente, luego Premiere tiene que crearla, y
eso se lleva su tiempo. El tiempo de calculo depende de:

- Complejidad y numero del filtros / transiciones

- Velocidad del procesador

- Cantidad de memoria

- Tamafio del video y profundidad de color

- Si tenemos alguna tarjeta que aplique en tiempo real compresiones y/o filtros y/o transiciones

Cuando nuestro equipo no puede satisfacer alguna de las demandas anteriormente descritas, es imposible
aplicar los efectos en tiempo real. Las soluciones que aporta Premiere son las vistas en el apartado Preview

(previos)

Estas vistas previas se generan utilizando el codec de compresion que hayamos elgido para nuestro proyecto
(Ver 2.2 Video) Como dije entonces, y mantengo ahora, nos conviene utilizar un cdédec rapido para no demorar
mucho este proceso (excepto cuando volquemos directamente el video a VHS desde Premiere, ver 3.1 Volcar a
video (print to video).

3.6 Export (exportar)

Si importar es incluir archivos en nuestro proyecto, exportar es justo lo contrario. Una vez terminado nuestro
proyecto, esta claro que habra que darle salida de alguna manera. Con Adobe Premiere 6 podemos hacerlo de
cuatro formas distintas.

- Print to video (volcar a video): Para grabar en VHS

- Print to tape (volcar a cinta). Para grabar en videocamaras miniDV con entrada de video (DV-in) activada

- Export Movie (exportar pelicula): Para grabar el video en formato MOV, AVI, DivX o MPEG y de ahi,
probablemente, a un VCD, SVCD o DVD

- Save to Web (guardar para la web): Para usar algin formato de streaming o video por internet (y alguna
opcion mas)
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(ver El ultimo paso: la exportacion)

4. Importando nuestro material audiovisual a Premiere

Con Premiere trabajaremos comodamente con imagenes fijas, audio y, por supuesto, video y, como hemos
visto (ver IMPORTANTE), en la mayoria de los casos las caracteristicas del proyecto seran idependientes, y por
tanto direferentes, de las de los elementos audiovisuales con los que trabajemos.

Los archivos se importan a través de la ventana de proyecto (Ver 1. La ventana de proyecto) y como norma
general debemos procurar usar originales de la maxima calidad, puesto que para exportarlos siempre acabaremos
comprimiéndolos y, por tanto, reduciéndoles calidad en mayor o menor medida. Trataremos de seguir las
siguientes recomendaciones.

- Video: De ser posible, hay que evitar trabajar con video comprimido y muy especialmente videos MPEG
(Ver 2.2.2 Los formatos AVI y MOV) En cuanto al tamafio, lo mejor es trabajar en su justa medida. Si usamos
video con menos tamafio que el destino (importar archivos 352x288 para un destino final DVD PAL 720x576,
por ejemplo) esta claro que perderemos calidad puesto que se tendran que afiadir pixeles que no existen en el
video de origen. El proceso contrario tampoco es recomendable. Si tenemos un video 720x576 cuyo destino es
un VCD PAL 352x288 esta claro que no perderemos calidad, pero mientras que hagamos la edicion estaremos
calculando un montén de pixeles para las transiciones y filtros que no usaremos en el video final, una pérdida de
tiempo bajo mi punto de vista. Eso sin contar por supuesto con todo el espacio extra que necesitamos para
trabajar en calidad DVD. Mi recomendacion es, por tanto, capturar o usar videos del mismo tamafio de salida.
De no ser posible, como en el caso de SVCD que no suele venir entre los formatos de captura, entonces si que
recomiendo capturar con el tamafio inmediatamente superior. Es decir, si nuestra capturadora sélo ofrece
352x288 y 720x576 para PAL y queremos hacer un SVCD PAL 480x576 entonces si, capturaremos a 720x576

- Audio: Para el audio se puede aplicar las mismas recomendaciones que para el video. Hay que procurar no
usar Mp3's de origen ya que presentan de partida una reduccion de calidad que al comprimir de nuevo para
exportar sera mas acusada. Hay que prestar especial atencion a las frecuencias de muestreo. Usar un original de
48 kHz de frecuencia para un destino final de 44.1 kHz no supone ningun problema, sin embargo el proceso
contrario si. Se suelen presentar variaciones en la velocidad de reproduccion, sonido metalico y/o chasquidos. Al
igual que con el video, lo mejor es capturar o usar audio con la misma frecuencia que el destino de salida. Para
DV o DVD seran 48.000 Hz, mientras que para VCD / SVCD seran 44.100. DivX puede usar el que sea.

Si te ves en la situacion de tener que pasar un archivo de audio con una frecuencia inferior a una superior,
recomiendo usar ssrc (incluye manual de uso)

Layer Selection: Flor pirput : - Imagenes: Para las imagenes, en principio, no hay que
tener ninguna consideracion especial. Por supuesto, cuanta

Choose 3 layer: - |Merged Layers = mayor calidad mejor y, si las vamos a usar a pantalla completa,

Background . lo mejor serd también que tengan el mismo tamaino que el del
0K | Previo a la ceremoania .
Prévio a la ceremania copia destino final (VCD, SVCD, DVD) En cuanto a los formatos
Ceremania admitidos estan los mas comunes: BMP, GIF, JPG, TIFF,
Ceremonia copia TARGA 'y, por supuestisimo, Adobe Photoshop (.psd) Cuando
EEE: copia importamos imagenes de Photoshop con varias capas se nos
presenta un cuadro de dialogo que nos da la oportunidad de

Ierged Layers importar la imdgen sin capas "Merge Layers" (fundir capas en
una sola perdiendo las transparencias) o bien podemos
mantener las transparencias de cada capa importanto las distintas capas una a una lo que quiere decir que si
queremos importar una imagen de 4 capas y queremos manipular esas 4 capas por separado, tendremos que abrir
ese archivo 4 veces y seleccionar una capa distinta cada vez. El efecto es el mismo que abrir 4 imagenes por
separado.

5. Capturando con Adobe Premiere

Para capturar video analdgico (videocamara o VHS) ni me lo pienso: uso Virtual Dub o AMCap. Sin embargo,
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si que me gusta usar Adobe Premiere para las capturas de miniDV. Lo primero que debemos tener en cuenta es
que solo podremos romper la barrera los los 4GB de captura si usamos un sistema operativo con particion NTFS
(Windows NT 4.0, 2000 o XP) jOjo! No basta con tener 2000 o XP instalado, si al instalarlo usamos particiones
FAT32 (las usadas para Windows 98/ME) no nos vale. Esas particiones tienen un limite para cualquier archivo,
incluidos los de video, de 4 GB, lo que limita muchisimo a la hora de capturar. Ademas, razones técnicas (digase
cuelgues y manejo de memoria) hacen mucho mas recomendable usar Windows 2.000 / XP sobre otras
versiones.

Dicho esto, os remito al manual de Virtual Dub si queréis capturar analdgico y durante este apartado me
referiré tan solo a la captura desde una videocdmara DV, aunque, todo sea dicho, la captura desde una fuente
analdgica es muy similar a la DV y por tanto, las indicaciones de éste manual servirdn también parcialmente para
ese tipo de captura

5.1 Caputando desde videocamara DV

Una de las principales novedades de Adobe 6 frente a la version 5 es su capacidad para trabajar con camaras
DV. Como vimos en el apartado 2. Primer paso: eligiendo proyecto Lo primero que deberemos hacer antes
siquiera de capturar (aunque se podria hacer desde directamente desde la interfaz de captura) es definir las
caracteristicas de nuestro proyecto. En el caso de DV es LO MAS FACIL DEL MUNDO. Basta con seleccionar
el tipo de video de destino (PAL / NTSC, 4:3 / 16:9, Audio 48 kHz / 32 kHz) y todo quedara ajustado.En cuanto
al audio, recomiendo usar siempre 48 kHz en la grabacion, captura, y por tanto, también en el proyecto.
Excepto para DivX, usemos el destino que usemos, necesitaremos siempre una frecuencia superior (44.1 o0 48
kHz) con los problemas que eso acarrea.

5.1.1 Ajustando las propiedades de captura del proyecto

Mas arriba, cuando vimos como ajustar las propiedades de nuestro proyecto nos dejamos pendiente el
apartado de captura. Ha llegado la hora de ajustarlo. Puesto que no tenemos ningtn dispositivo de captura
definido, si inicidramos la captura por primera vez, Adobe Premiere abriria automaticamente una ventana de
configuracion. No obstante, iremos paso a paso a esa ventana antes de intentar capturar. Antes de tocar otra
cosa, nos limitaremos a ir al ment "Project" (proyecto) y luego a la opcion "Project Settings -> Capture"
(ajustes del proyecto -> Captura) Aqui apareceran distintas opciones dependiendo de nuestro sistema. En
nuestro caso, para capturar desde DV deberemos seleccionar "DV IEEE 1394 Capture" en el apartado Device.
Si todavia no tenemos conectada la camara, o si no esta encendida aparecera "Unable to connect to capture
driver" (Conexion con el controlador de captura fallida) Es hora de conectar nuestra videocdmara.

Indicar aqui que trabajar con videocamaras DV a través de una tarjeta FireWire es realmente sencillo. Con
Windows XP / 2.000 no tendras que configurar nada. Instala la tarjeta y automaticamente sera detectada y
configurada por Windows. Lo mismo sucede cuando conectas por primera vez la videocamara. El sistema
operativo la reconoce y a partir de ese momento ya esta operativa y lista para usar.

Project Settings

L
—{Capture x| oK

Capture Format:  |D%/IEEE1394 Capture x|

W i ——— Device Control
¥ Capture Yideo O Settings. . |
Prerall Time: |5 seconds

Timecode Offset; |III 1/d frames

_ancel

Load

i o Using Reel Marme:
| I Log Using : Save

V¥ Capture Audio
¥ Report Dropped Frames

™ abort on Dropped Frames
™ Capture Limit; |E|I:|I:| SeC

Prey

ke

[ext

Las opciones que podemos ajustar aqui son:
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- Capture video (capturar video) Si no la seleccionamos no podremos capturar

- Device Control (control del dispositivo) Con éstas opciones definiremos como se comunica Premiere con la
videocamara.

- Preroll Time (Rebobinado previo) Especifica el tiempo que rebobinard la cinta antes de comenzar a
reproducir el video en el punto deseado. Esto se hace asi para dar tiempo a la cinta a reproducirse a la velocidad
adecuada y con el cabezal correctamente ajustado.

- Timecode Offset (desfase de codigo de tiempo): Normalmente no modificaremos esta opcion, que corrige
un posible desfase entre el contador de la videocamara y el de Premiere, lo que daria lugar a errores en la
precision de los puntos de inicio y final de captura.

- Log Using Reel Name (Registrar usando el nombre del rollo) Ver Batch Capture

- DV Settings (ajustes DV)

- During Preview (durante la vista previa)
- Preview video on desktop (ver vista previa del video en el ordenador) Muestra el video en el ordenador
durante las vistas previas
- Preview audio on desktop (ver vista previa del audio en el ordenador) Reproduce el audio en el
ordenador durante las vistas previas.
- During capture
- Preview video on desktop (ver vista previa del video en el ordenador) Muestra el video en el ordenador
durante la captura
- Preview audio on desktop (ver vista previa del audio en el ordenador) Reproduce el audio en el
ordenador durante la captura.

- Capture Audio (Capturar audio) Desmarcar si no queremos o no necesitamos el audio

- Report dropped frames (avisar de la pérdida de cuadros)
- Abort on dropped frames (cancelar si se pierden cuadros)
- Capture limit X seconds (Limite de captura X segundos)

5.1.2 Ajustando las preferencias de captura
A continuacion vamos a modificar las preferencias de captura que se mantienen con todos los proyectos.

"Edit -> Preferencies -> Scratch discs and device control" (Editar -> preferencias -> Discos de trabajo y
controlador de dispositivo"

- Captured Movies (peliculas capturadas) Aqui seleccionaremos en qué parte de nuestro disco se almacenaran
las capturas. Por defecto aparece "Same as application" (la misma que el programa) Pero eso no nos interesa
(consulta el apartado El disco duro dentro de problemas frecuentes de captura) Pinchamos ahi y seleccionamos
"Select folder" (seleccionar carpeta) y elegimos la ruta deseada. El lugar elegido quedara indicado justo debajo
al lado de "Path" (ruta).

- Video Previews (vistas previas de video), (ver 4. Vistas previas) Aunque para la localizacion de los archivos
de las vistas previas no hay que ser tan exigente como para las capturas puesto que su duracion es menor y hay
menos riesgo de bajada de rendimiento por fragmentacion, también ha de ser un lugar de acceso rapido y
preferiblemente sin fragmentacion. Por defecto aparece la opcion "Same as project” (la misma que el proyecto)
que podemos cambiar al igual que antes con "Select folder" (elegir carpeta)

- Audio Previews (vistas previas de audio) Es recomendable tener el video localizado en un disco duro y el
audio en otro, aunque el del audio sea un disco duro lento. De ese modo el sistema puede leer simultaneamente
video y audio. De lo contrario, de usar un sélo disco duro, el cabezal tendria que saltar alternadamente de un
lado a otro del disco para ir leyendo video / audio. Al igual que la opcion anterior, por defecto aparece "Same as
project” (la misma que el proyecto) que podremos cambiar con "Select folder" (cambiar carpeta)

D¥ Device Control Options - - Device control (control del dispositivo) Con esta opcion le
indicaremos a Premiere qué camara tenemos conectada para
Yideo Standard: [PAL =l que se comunique con ella de manera adecuada. Pinchamos en
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Device Brand: |GEECIE "None" que aparece por defecto, y seleccionamos "DV Device
control 2.0" y aparece automaticamente las opciones (el mismo
menu que aparece al pinchar sobre el boton "Options" una vez
Timecode Format: |Non Drop-Frame =] configurada)

Device Model: [NY-DS254 =l

Checl Status |: Bl : Videp Standar: PAL (Europa) 0 NTSC (América.y Japon)
- Device Brand (Marca del dispositivo): Aqui elegiremos el
fabricante de nuestra camara. Si no aparece, usaremos
(04 I Cancel | " o
Generic

- Device Model: Una vez seleccionada la marca, aparecera
una lista de modelos de ese fabricante. Si no aparece el nuestro, dejarmos "Generic"

- Timecode Format: Desconozco su funcion. Mi videocamara tan s6lo me deja seleccionar la que aparece en la
imagen, y el manual de Premiere tan solo indica "Elija la opcién adecuada para su videocdmara"

5.1.3 Iniciando la captura
Una vez ajustados todos los parametros necesarios vamos a "File -> Capture" Aqui tenemos tres opciones
5.1.3.1 Batch capture (captura programada)

La captura programada, como su nombre sugiere, es una captura "desatendida" en la que le indicamos a
Premiere los puntos de inicio y fin de la captura y €l s6lo va capturando. Esto tiene dos ventajas

- Por un lado no es necesario que estemos presente durante las capturas

- Por otro lado, al definir con precision los archivos con los que trabajaremos (los puntos de inicio y fin en la
cinta original), podremos capturarlos primero en un proyecto con baja resolucion para hacer una edicion rapida,
puesto que seran archivos pequefios y manejables, y una vez terminado el proyecto podremos volver a usar LOS
MISMOS PUNTOS de inicio y fin para cada archivo capturado, pero con un proyecto de una mayor resolucion,
de manera que aunque hemos trabajado con poca calidad en el proyecto podremos exportar el resultado de
nuestra edicion con la maxima calidad posible puesto que los clips seran los mismos.

Para ver como usar este tipo de captura consulta el siguiente apartado, o ve directamente el punto 5.1.3.3
Usando la ventana de tandas (Batch Capture)

5.1.3.2 Movie Capute (captura de pelicula)

Esta seré la opcion que utilicemos para capturar video. Puesto que nosotros ya hemos definido las
preferencias y propiedades del proyecto, (ver 5.1.1 Ajustando las propiedades de captura del proyectoy 5.1.2
Ajustando las preferencias de captura) aparecera directamente la siguiente pantalla. En realidad aparecera
seleccionada la pestafia "Settings" (ajustes) pero como digo, ya tenemos definidas las preferencias y propiedades
de la captura, de modo que pincharemos en la pestafia "Loggin" y pasaremos directamente "a la accion"
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:Movie Capture

=101 x|
Reel Name: (001 |
File Narne: | |
Comment:

n: [00:00:00:00 Set In |
Cut: [00:00:00:00 Set Out |
Duration: [00:00:00:01

Capture IndCut | Log In A Cut |

L Wl i} [

Cuando capturamos desde una cdmara DV tenemos varias formas de hacerlo

1. La mas "tradicional" coincidiria con el modo de captura analdgico y seria reproducir el video en la

videocamara y pichar sobre el boton ® para iniciar la grabacién y en el boton L para detenerla, pero con una
camara DV, eso no "mola"

2. Desde Premiere podemos controlar la videocamara a nuestro antojo. Si alguna vez has editado video con
una mesa de mezclas "tradicional", esto te va a saber a gloria... porque te sentiras en casa. Podemos ir
definiendo una serie de puntos "in-out" (inicio-fin) de modo que capturemos tan sélo lo que queremos, y ademas
de una forma desatendida. Es decir, que como le indicamos a Premiere lo que queremos capturar y ¢l maneja la
camara, no es nesario estar presentes durante la captura. Y €sto no so6lo es valido para un punto in-out
(inicio-fin) sino que podemos definir todos los in-out (inicio-fin) que queramos. Antes de ver como hacer ésto,

echémosle un ojo a los controles de los que disponemos. Algunos son de sobra conocidos por todos, pero hay
otros que quizas los veas en Premiere por primera vez.

- Ml Retroceso cuadro a cuadro
- Avance cuadro a cuadro

- parada

- ¥ Reproduccion

- Bl Retroceso a camara lenta

- ¥ Avance a camara lenta

- 44 Rebobinado rapido (si pichamos durante la reproduccion se avanzara visualizandose la imagen)
- ¥ Avance rapido (si pichamos durante la reproduccion se avanzara visualizindose la imagen)

- Il Pausa

- ® Grabacién

1 Set In (marca de inicio)

b Set out (marca de fin)

- == Shuttle (Barra de desplazamiento) Desplazando esta barra podremos elegir de forma manual
la velocidad de avance/retroceso de la cinta.

Una vez situado el video en el punto de inicio deseado, pinchamos sobre Set-in. Avanzamos la cinta hasta el
punto de fin, y pinchamos sobre "Set-out"

Logging

(G- ey Nombre de la cinta|
_p—— [ » - . ) 1

Settings Si solamente queremos capturar esos puntos es suficiente con pinchar en

"Capture in/out". Como he dicho antes, Premiere tiene un control total de la
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REENneeOmBre ael archivg | videocamara, de modo que da igual en qué punto se encuentre la

Comnment: videocamara, Premiere la llevara al punto de comienzo, la rebobinara los
segundos que especificamos en las Preferencias del Proyecto (ver5.1.1
Ajustando las propiedades de captura del proyecto) y comenzara la captura
justo hasta el punto out. Una vez terminada la captura nos preguntara por un
nombre para ese archivo "File Name" (nombre de archivo) y nos da la

n: pooniooon | setin | opcion de poder afiadir cualquier comentario personal a ese fichero.

Out: [A0:00:00:00 setout | Si lo que queremos es capturar diversos puntos de la cinta, entonces
Duration: [00:00:00:01 usarmos la opcion "Log in/out" (guardar in/out) y Premiere nos preguntara,
Capture IndOut I al igual que con Capture in/out un nombre de archivo (File Name) y un
comentario opcional, pero esta vez no lo hara después de hacer la captura,
Capturar sino antes. Una vez indicado el nombre, aparecera la ventana de tanda de
infout captura en la que veremos los datos de la captura que hemos definido. La
Anadir a tanda opcion "Reel Name" (nombre de la cinta), que se define en la ventana de
captura, es optativa y tan solo sirve en el caso de ir capturando de diversas

cintas por ir manteniendo un poco de 6rden y saber qué es cada cosa. El procediemiento para el resto de puntos
in/out es el mismo

Log In At

5.1.3.3 Usando la ventana de tandas (Batch Capture)

i Batch Capture: Untitled3.pbl

; =101 x|
| Feel Mame In Point ot Point Lk ation File Marne Log Cornrnent Settings | »
v Cinta 1 a0:03:28:02 Oo:04:17:04 O0:00:49:03 Trampo Un trompo espectac. =
# Cinta 1 a0:04:32:02 Qo:04:39:21 a0:00:07: 20 Pique Batalla en plena curva

Cinta 2 00:05:35:08 00:05:44:01 00:00:038:19 Final Un final espectacular
blln socaptura v =P Capturado ¢ —p Pendiente de captura Grabar 41 Borrar
Total Duration: 00:01:05:17 Uncaptured Duration: 00000720 | @ [ S R | & | 4

Una vez definidos todos los puntos, hemos de pinchar sobre el boton de grabacion ® de la ventana de tandas
(Batch Capture) y Premiere nos dard un mensaje de aviso para que introduzcamos la cinta ninero 1 (por si
hemos trabajado con varias cintas) Le damos a aceptar y el resto del proceso se realizara automaticamente.

Todos estos archivos, ademas de guardarse en el directorio que hayamos definido en las Preferencias (ver
5.1.2 Ajustando las preferencias de captura) se afiaden automaticamente a la ventana de proyecto (Ver 1. La
ventana de proyecto)

5.1.3.4 Stop Motion (sin movimiento)

Hace una captura de un sélo fotograma, es decir, de una foto fija. Aparece una ventana con un boton arriba
"Capture" Cuando tengamos la imagen que queremos pinchamos sobre ¢l y aparecera la imagen que hemos
capturado. Cerramos la ventana (con la X de la esquina superior derecha) y nos preguntara si queremos
guardarla. Si es lo que queremos, decimos que si y elegimos donde la vamos a guardar. La imagen se guardara en
formato BMP, es decir, sin compresion de ningln tipo, y sera del tamafio que hayamos definido el proyecto.
Para otras imagenes s6lo tenemos que repetir el proceso.

NOTA: Cuando capturamos una imagen de una fuente entrelazada, como sucede con video DV, no habremos
capturado un cuadro, sino un campo (medio cuadro) Podremos mejorar la calidad NOTABILISIMAMENTE
desde Photoshop con "Filtro -> Video -> Desentrelazar"

5.1.3.5 Audio Capture (captura de audio)

Adobe Premiere no dispone ningiin modulo especifico para la captura de audio, de modo que lo Unico que
hace esta opcion es preguntarnos por la localizacion de algin programa de tratamiento de audio y lo inicia, de
modo que el proceso de captura de solo audio es externo a Premiere. Para modifcar archivos de sonido
recomiendo GoldWave por su sencillez, pero a la vez potencia para la mayoria de modificaciones y capturas de
audio. Por otro lado, también recomiendo Sonic Foundry Sound Forge por su potencia para hacer realidad todos
nuestros deseos en audio. Eso si, es un tanto complicado de manejar (pero para eso tenemos a Jordy Max
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trabajando en un manual...)
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